
UO Template Editor 

Manual revision 3.0 

 

Index Of Contents 
 

 Part I (Introduction) 

o The Purpose of This Software 

o Software Overview 

o Installation 

 

 Part II (Basic User Guide) 

o Stat/Skill Area 

o Equipment Area 

o Advanced Info Area 

o Spell Damage Area 

o My Stable Area 

o Crafting Info Area 

o Notes Area 

o Basic Tools Guide 

 Item Maker 

 UO Assist Item Import 

 Enhanced Client Mod Installation 

 Item Set Maker 

 Bestiary 

 Taming Table 

 Champion Spawn Table 

 Slayers Table 

 Peerless Key Guide 

 Collector’s Library 

 

 Part III (Advanced User Guide) 

o Files Structures 

o Command Line Parameters 

o Add Your Own Skills, Item Properties and Caps 

o Multi-Language Support 

o Freeshards and OSI: What You Can’t Change 

 

 Part IV (Support and Future Releases) 

o How to Get Tech Support 

o Limitations and Warranties 

o Feedback and Donations 

 

  



Part I – Introduction  - 

 

The Purpose of This Software 
 

 

The intent of this program is to keep and share your Ultima Online® character’s template. 

Actually there are no software  around that do this kind of tasks; I saw only few sites that allow to load your equipment 

with limited item properties and no supports for skills or pets. The software that I used before starting to work in UO 

Template Editor was Ultima Online Utility that allow to load skills and main item properties, but not support item 

naming, bonus skill and item layer like belt, earrings, etc… 

You can run it in every computer with Windows XP ™, Windows Vista ™ or Windows 7 ™ installed. The only limitation is 

the needle of the .NET Framework 2.0 installed on the computer. 

Probably you are asking “Why should I use this program?”. Well, answer these questions first:  

 Have you ever desired to try to change parts of your equipment and see what will be your total properties?  

 

 How many time you have entered on a spreadsheet your equipment data for get your resistances sum or your 

spell damage or your hit chance and discover that there is a wrong formula somewhere that make a wrong 

sum? 

 

 How many time you have send your spreadsheet to a guild friend and he can’t open the file because  he doesn’t 

have the spreadsheet software or has an incompatible version? 

With this software you can solve every problem of the spreadsheets and you’ll have the best way to see the main 

characteristics of your character without spend time in formula and money to buy items that probably will be useless for 

a little calculation error. 

  



Software Overview 
 

Now let’s see the main softwares feature before deciding if you need it or not. 

Here is the main window:  

 

It may not be the best graphical interface that you have seen, but hey! It works and its FREE!  

In the main window you can adjust your stats and your skills (see below).  

Bonus values for stats and skills are automatically added by the items so you don’t have to worry about it. 

 

 

 

Now let’s take a look to the menus: 



  

File menus contain standard functions like save, load, new, exit and the links to UO Herald and UO Japan web pages. 

The “Load Recent Character” menu, will show the last 10 edited characters. 

The Tools menu contains some tools that allow you to customize the software: 

 Item Maker: allow you to make your own items (the package contains the main artifacts: doom, tokuno, 

ilshenar, stygian abyss, replicas, peerless boss, 7th anniversary, 8th anniversary and the veteran 

robes/cloaks/dresses) 

 Import UOAssist Items: allow you to import the items from the “Vendor Agent” of UOAssist 

 Item Set Maker: allow you to select the set’s item parts and to add the complete set bonus (the package 

contains the Mondain’s Legacy™ sets, the “Spring Cleaning 2008” event sets and the virtue armor set) 

 Enable Caps Editing: allow you to change the items cap in the “Equipment” area (see “Add Your Own Skills, Item 

Properties and Caps” of this manual for more informations). The package has the OSI default property caps. 

 Pet Type Maker: allow you to make the basic pet types to use in the “My Stable” area (the package contains the 

following pets: Bake Kitsune, Cu Sidhe, Dread Warhorse, Fire Steed, Greater Dragon, Hiryu, Lesser Hiryu, 

Nightmare, Reptalon, Rune Beetle and White Wyrm) 

 Cleaner: allows you to safely remove leftover program bits. It’s possible the program can generate exceptions or 

many files can remain somewhere in your folders. I suggest to always use the cleaner for delete characters, 

items and pet types. 

 Import Character: allows you to import a template shared by someone else 

 Export Character: allows you to export your character template for share it. Exported templates could be 

imported by anyone with UO Template Editor 1.2 or newer version. 

 Password Generator: allows you to generate new passwords for your account or test the strengthens of your 

own. 

 Bestiary: allows you to get information about all the creatures available in game. 

 Collector’s Library: allows you to manage your items collection. 

 Third Party Tools: allows you to start an external tool. See the advanced guide for more information. 

You will see in the Basic and Advanced Guide (below), that you can customize every item property and skill. The most 

customizations can be done through this few tools. 

 

  



Let’s take a look to the Equipment area: 

 

Here we can see every character’s slots on the left, the property sum on the right and down, we can see the list with all 

completed sets. Further down there is the active spells selection. 

  



The advanced info area: 

 

Here you can see the most useful information that you could ever need. 

  



The spell damage area: 

 

Here you will see the damage of your spells based on your skills and items. You can also set a circle or apply the Arcane 

Empowerment and Reaper Form spell for increase your spell damage.  

NOTE: Arcane Empowerment and Reaper Form requires 24 in spellweaving skill to be used.  



And now the stable area: 

 

It looks a bit empty, eh? Don’t worry, you have 16 slots available per character to loads up your favorite pet! Why do 

you see only 3? Well you need to set the right Animal Taming, Animal Lore, and Veterinary amount to unlock the others 

(as in game). 

  



The crafting info area: 

 

By choosing a crafting skill, you’ll see the exact success chance to make an item with the worn talisman bonus.  

  



Let’s take a look into the annotation area: 

 

Here you can write whatever you like, there is also some formatting tools common to all the rich text editor. There is 

more information below.  



 

We are arrive at the last part of the overview. The tool exploration! 

 
The item maker is an easy tool. Just fill the table and for each property you will see the imbuing weight changing. 

The imbuing weight property could be very usefull if you wish to modify one item with imbuing or if you have to create 

it. In the bottom empty parts of the window you will be able to see the Imbuing reagents required for a single property. 



 

The item set maker looks a bit more difficult to use but don’t worry; I’ll explain more later. 



 

And at last (but not less important): the Cleaner. 

 

The bestiary allow you to see lot of data about the monsters. With this tool come other tools: 



 

The taming table is the first bestiary tool that allow you to sort and check the taming and control chance for each 

tamable creature. 



 

The champion spawn table shows champion spawns information. 

 

The slayer table shows every available slayer and the affected monsters. 



 

And this, is the last  bestiary tool, the peerless key guide. 

 

This one is the Collector’s Library tool, used as a list and source of information for lots of items. 

Our overview is complete. Let’s get into detail! 



Installation 

 
Install UO Template Editor is very easy! 

PREREQUISITE: .Net Framework 2.0 (downloadable from 

http://www.microsoft.com/DOWNLOADS/details.aspx?familyid=0856EACB-4362-4B0D-8EDD-

AAB15C5E04F5&displaylang=en)  

NOTE: Windows Vista and 7 has the .Net Framework 2.0 installed by default, Windows XP user have to manually install 

it. 

 

The UO Template Editor package is distributed by “guain.it” domain for FREE, other domains are not warranted for your 

computer safety. 

 

Install instructions: 

 

Simply download the package and unpack it wherever you like. If you don’t have the .Net Framework 2.0, you have to 

install it before run the application. 

Once you start it, the program will allow you to open all its files (characters, items, set, pet and exported characters), 

just by double clicking them (like you do with your mp3 files!) 

 

The package Contents: 

 

- Artifacts (Doom, Treasures of Tokuno, Paragon, Stygian Abyss, Replicas, Peerless, Faction artifacts, Veteran 

Reward Robes/Dresses and Cloaks, 7th and 8th anniversary items), and much more items! 

- All game creatures with pictures and available data. 

- Item Sets (all Mondain Legacy™ sets and Spring Cleaning 2008 event sets) 

- All craftable items file (for success chance calculation) 

- All peerless key guides. 

- All armors and weapons basic images and data. 

- All skill training guides. 

- All items collection and information available around. 

- English and Italian language pack. 

- Program startup files    

http://www.microsoft.com/DOWNLOADS/details.aspx?familyid=0856EACB-4362-4B0D-8EDD-AAB15C5E04F5&displaylang=en
http://www.microsoft.com/DOWNLOADS/details.aspx?familyid=0856EACB-4362-4B0D-8EDD-AAB15C5E04F5&displaylang=en


Part II - Basic User Guide - 

Stat/Skill Area 
 

Here we are, let’s see how to use the Stat/Skill Area! 

 

  



I have divided the window in 8 parts, let’s see one by one: 

1. The Character’s Name is a must, the first thing to type before forgetting about it 

The Shard Name is optional, you can pick one from the list or leave it empty. 

The rectangle is the Avatar part. The avatar size are 64x74 px and you can change it by the context menu: 

  
Once you have loaded an avatar, you will be able to remove it, or save it for other uses (like forums avatar). 

 

2. The Character’s Race is another must, you must choose it before start to add equipments or you can lose some 

items when you change the Race. Remember that in game there are lots of items with a race flag like “Elf Only” 

or “Gargoyle Only” 

 

 Gargoyles can wear only the “Gargoyle Only” items 

 Elves can wear “Elf Only” items and the items without the race flag 

 Humans can wear only the items without the race flag 

You can see the race advantages by put the mouse cursor on the race name 

 

 

3. When you try to set the Strength, Dexterity or Intelligence it will appear this slide bar: 

 
this allow you to set the stats at your pleasure inside the cap limits. However the stats has a natural cap of 125 

and 150 with item bonuses 

 

4. The stat cap dropdown list give you a choice of every kind of stat cap available in the game from 225 to 255 and 

will be your stat limit (Strength + Dexterity + Intelligence cannot go further than that value, except with item 

bonuses) 

 

5. This big table is your skills list. Push the “Add Skill” button for insert a new skill and will appear a new line in edit 

mode into the table: 



 
 

Here you can choose the skill manually by the dropdown list or by typing it. When you start to type the skill name, the 

program start to auto-complete your text until you have found the right one. 

 

If you want an higher limit (cap) for that skill you have to click on the “Your Cap” cell: 

 

 
and choose your cap from 100 to 120.  

NOTE: only the skills that in game can go higher than 100 allow you to choose a cap, the others will never show this 

menu! 

Now you are ready to choose your real value (the skill value without item bonuses) by clicking the “Real Value” cell: 

 

Then type your value inside the box. When you have entered the value, press ENTER or click somewhere in the screen 

for confirm. 

Now you have 1 skill in the table: 

 

You can keep this skill here or load it in a soulstone (check point 7 for more informations).  

NOTE: You can load in a soulstone only those skills with a real value higher than 0! 

If you click the “Soulstone Skill” button it will be prompted if you are sure, because if you want it back you must have 

enough skills point in your total cap (check next point for more information). 

If you click the “Remove Skill” button it will be prompted if you are sure. Remember: once removed the skill cannot be 

recovered, and if you want it back, you have to add it again. 

NOTE: You cannot remove skills with item bonus, for remove that skills you have to remove the item first. 

Once the skill is added you can change it by 2 slow click on the name (like to rename a file), the skill cap and real value 

can be edited by clicking on them. The “Bonus Value” and “Total Skill Value” are automatic and cannot be edited. 



If you want, you can use the right mouse click on the skill line and discover how to train it! 

 

If you click on “<Learn how to raise <your skill> …” a new little window will open with a quick quide on how to raise your 

skill:  

 
This window contains only text and  can be edited by clicking “Enable Editing” on the file menu. Could be also freely 

resized. 

 

6. This is the skill caps part. The caps on OSI start from 700 and is raised automatically by 5 per year up to 720: 

 
On the right of the cap you can see the box which contains the sum of all skills that cannot go further than the 

chosen cap except for the items bonus. 

 

If you want to see the value without bonus, tick the “Show Real” checkbox and the number will be automatically 

updated. If you remove the tick the value will return as it was. 

 

If you tick the “Show Overcap Values” you allow the bonuses to bring the skill over each cap. Sometimes this 

function can be useful for see how many extra points do you have. 

  



 

7. The “UO Assist: import stat and skill from the logged char” button allow you to acquire the main character data 

from your logged character. 

BEFORE DO THAT REMEMBER: 

 You must have the game opened with UO Assist active AND registered (there are rumors about other 

programs like UO Assist, but UO Template Editor is not designed for them) 

 Put in the backpack all the items with bonus to Strength, Dexterity and Intelligence or the stat values 

will be wrong 

 When done, check all the collected data and fix eventual mistakes. 

 You can use this ONLY before enter any kind of data manually, otherwise the button will be disabled. 

 

The “EC: import stat and skill from the logged char” button allow you to acqyare the main character data from 

the Enhanced Client. 

BEFORE DO THAT REMEMBER: 

 You must have the Enhanced Client open with the character you want to import logged in. 

 You must have the UO Template Editor client mod installed. 

 You must type (in game): “I wish to export my character” 

 When done, check all the collected data and fix eventual mistakes. 

 You can use this ONLY before enter any kind of data manually, otherwise the button will be disabled. 

 

8. When you add a soulstone it will appear in this area in blue, red or green. Colors mean nothing, they’re just for 

indicating they don’t have all at the same colors ingame. 

 
Here you will see under the soulstone the skill name and the real value of it.  

NOTE: the program will store the skill bonuses too! 

 

If you click the “Absorb” button, the program will try to bring the skill back to the table. If you don’t have 

enough point a message will inform you and the skill remain here. 

 

If you click the “Destroy” button, the program will try to trash this skill, but if you have items that give bonus at 

this skill, the bonuses will be listed once again in the skill list. 

NOTE: a message will ask you to confirm the destruction, if you wrongly say yes, you cannot recover the stone 

anymore. The lone way to get it back is load the skill in the skill list and put it in a soulstone again. 

  



Equipment Area 
 

The equipment area is a complex part of this program. There is a lot of item combination and layers. 

First we must say what items you can add: 

If you are HUMAN you CANNOT use “Elf Only” and “Gargoyle Only” items, if you try to load it they will be automatically 

removed. 

If you are ELF you CANNOT use “Gargoyle Only” items, if you try to load it they will be automatically removed. 

If you are GARGOYLE you CAN use the “Gargoyle Only” items and nothing else (except for earrings, rings and bracelets). 

Gargoyles CANNOT load nothing in HEAD or GLOVES. 

If you want to complete an item set, just add all the parts and the set bonuses will be automatically applied to each 

parts and the unique bonuses will be visible on the “Completed Sets” part 

 

Ok, let’s see the area now: 

 



1. This is the layers area. You can click in the button with “<NONE>” inside and a list of items for that layer will 

appear: 

 

 
 

Every items in that list can be used (instead of the ones that break the racial rules, if you load one of them it will 

be automatically removed). The quick search will allow you to get what you are looking for (you can also scroll 

the list manually), simply type something in the list and the item will be automatically selected. 

Here is an example: 

We are looking for “Mace and Shield” glasses 

 
The item is selected after only 3 letters! 

 

When you have make your choice, push the “OK” button (or double click the item name) 

 

After that (if the item doesn’t break the racial rules), we can see the item name instead of “<NONE>” and if you 

put the mouse cursor over it, the program will show the property of the item. The big property list on the right 

you will see the item properties loaded (as you can see in the picture) 

 



 
Uh oh! The item loaded have a red name and the strength requirement is red too! What can I do? 

 

In this case the red name means that your character doesn’t have enough strength for wear it. However the 

program allow you to wear it (a “try before buy” that allows you to not modify the strength if you really don’t 

like it). Remember that you need to raise the strength if you really want to use this in game, because the game 

is not nice and will never allow you to wear it! 

 

You can also use the “Advanced Search”, allowing you to search for an item by its property. 

 
Just fill the property name and value and it will show the list of every items with those characteristics.  

(The “X” button allow you to reset the field if you have inserted something wrong) 



 
You can also click in a column for sorting the items based in the column contents. 

When you have made your choice, simply double-click the item or select it and press the OK button for use it. 

If you don’t get the item that you are searching for, you can also click “<New Item…>” in the item list for make a 

new item through the “Item Maker”. 

NOTE: you can see a tooltip with all the properties of an item if you put the mouse cursor over the name of an 

item (see the picture below) 

 
 

 

 

 

 

 

  



2. The property list will show the combined properties of the items that you are wearing. In the following image 

you will see what do you get after choosing the “Mace and Shield” glasses. 

 
When the cursor goes on a property, you will see the property description 

 
 

Why “Hit Lower Defense” is not listed? Because “Hit Lower Defense” and “Hit Lower Attack” cannot be 

combined. For example if you have 30 in the glasses and 40 in the weapon they will works separately: a hit has a 

30% chance and if it fails, the game will check again with 40% and so on for every item. It’s useful but isn’t a 70% 

chance, so the program will never show you that. 

NOTE: in the property you cannot edit anything. 

 

3. The Completed Sets area will show you the list of every completed set. Completing a set means you have to 

wear all the parts.  

 



 

 

When all parts are worn you can see the sets names and by click each set name, you will get the unique 

properties (the ones that cannot be added to each parts) 

 
You can’t edit anything in this little area, it’s all automatic. 

For removing a set, you have to remove 1 or more piece and the list will be automatically updated. 

 

4. The “Active Spell Effects” area allows you to activate the several primary spells/transformations and see how it 

would change your properties. 

 

“Reactive Armor” and “Protection” are always usable because don’t require more than 10 of mana or more than 0 in 

magery. 

For using the other spells you must raise the correct skills and possess enough mana. For more information about this 

spells, check the Ultima Online™ official playguide at http://www.uo.com. 

5. The “Drop All Items” button allows you to remove all the items at once 

6. The “Clone Equipment From…” button allows you to copy the equipment of another saved character. 

 

Special functions: 

You can use the right click on any layer for gain the access to the quick actions: 

 
 

- New Item: instantly open the “Item Maker” for create a new item for this layer. 

- Edit Item: Instantly open the “Item Maker” for edit the item on this layer. 

- NONE: remove the item from this layer. 

 

  

http://www.uo.com/


Advanced Info Area 
 

  

 

This area is very simple to use, almost everything is read-only. 

- The stamina Testbar could be moved for check how change your swing speed by dropping your stamina 

- The Hit Chance Calculator will show your chance to hit and get hitted by typing enemy skill, enemy defence 

chance and enemy hit chance. When you have entered all the requested data just press Enter and the result will 

be calculated. 

- The spell success chance combo box are very easy to use too. First select the skill, then select the spell and 

instantly the calculator will show your chance to successfully cast the spell (based on your skills) and the real 

mana cost taken (based on your Lower Mana Cost taken from the equipment) 

The rest of the data is read-only so you can read it and learn more about your character. 

  



Spell Damage Area 
 

This area is very useful for mages, because you can read the damage caused by each main attack spell available in game. 

  

Other than read data in the various tab (Magery, Spellweaving and Mysticism), you can also see the “Total Spell Damage 

Increase” which is the Items Spell Damage Increase + every bonus derived by Arcane Empowerment and Reaper Form 

(for use both you need at least 24 in spellweaving skill). 



The arcane circle can be increased by clicking on each mage, when you click on each one they became active: 

   

By clicking again on each mage you can decrease the circle. The Reset Circle button will bring the circle to level 0. 

The spells damage value, will change when you change items, skills, circle level or by enabling/disabling the Arcane 

Empowerment or Reaper Form.  



My Stable Area 

 
This area allow you to load every your stabled pet (especially useful for tamers). 

For start to load pets, you need to click on a free slot (for example the “<Slot1>”) 

 

After clicking it, a large table appears where you select the Pet Type by typing the name (helped by the auto-

completion) or by the dropdown list. 

After the choice of type come the name of your pet, and then you can start to type the attributes! 

 

In the table you can edit every cell in the “Your Value” column. The min/max values are a guide of how good is the pet. 

Note: Humans, due to their “Jack of All Trades” characteristic, have an effective 20 skill level in Animal Lore, and can 

usually get their pet information within several tries, even with no actual Lore skill. 



 

The cells begin with the same value of the minimal. Remember that you can’t add number lower than the “Min Value” 

and higher than the “Max Value” (if they are wrong, you can edit it with the pet type maker tool, see forward for more 

information). 

While compiling the table, some values will change: 

- Resistances Difference: this value is the sum of all “Your Value” resistances less the “Max Resistances”. The 

more near 0 is this number, best is your pet. 

- Pet Valuation: this is a small feature that rates your pets. It give 70 points for perfect resistances and 25 points 

for life and 5 points for the other stats, for a total of 100 points. 

- Damage: is the effective damage of the pet. 

- Breath Damage: is the effective damage of the pet’s breath attack. 

- In the bottom of the window you can read the chance to control and tame the pet with your actual skills. 

 

The red rectangle shows a judgment based on the points received: 

CRAP -> very low level pet 

Bad -> medium-low level pet 

Good -> medium level pet 

Excellent -> medium-high level pet 

Uber -> high level pet 

Perfect -> (almost impossible to get) this means that your pet has maxed attributes (life and resistances), so it’s 

perfect. 

 

 

When you press “OK” you will see the pet name instead of the “<SlotX>” that had you clicked before. 

If you click “Cancel” the process will be canceled, and nothing will change 



 
 

If you click your pet name, now you can edit again it’s attributes and confirm the changes by pushing the “OK” 

button, or “Cancel” if no edits are desired. 

 

If you press the “Remove Pet” button, your pet will be removed completely and cannot be recovered.  

When removed, the slot will be free again and you can load another pet. 

 

NOTE: if you have not saved the pet by pressing “OK” the “Remove Pet” button will do the same thing as the 

“Cancel” button. 

 

 

 

 

  



Crafting Info Area: 
 

 

In this tab you can see the effective success chance of crafting an item with a specific skill. 

When you select the skill, the table will be automatically updated, by calculating the success chance based on your 

actual skills. If you change the skills value, the table will be automatically updated. 

In the bottom of the window you can read the required materials for craft an item or eventually, the additional skills 

required. 

 

 

 



Notes Area: 
 

Here is the notes area: 

 

It’s very simple use this tool. Just type something, and format it at your pleasure. 

You have 4 type of text style: 

B -> bold 

I -> italic 

U -> underlined 

S -> strikeout 



All the fonts available in your pc: 

 

Obviously you can change the text size: 

 

The text color: 

 

And the text alignment: 

 

That’s was the basic, now you need to use your fantasy and write down something.  



Basic Tools Guide 
 

These tools are very important for use this program.  

Item Maker 

 

This little tool allow you to load your runic items or a custom one. 

To create an item enter the name in the “Item Name” textbox, then select the layer of the object (for example choose 

the head for hats or helm). Some layers has additional details to write down: 

- Head: this layer require the “Base Armor Type”. By opening the dropdown list you could see every kind of hats. 

- Armor Part: these layers requires the “Base Armor Type”. By opening the dropdown list you could see every 

kind of armor. 



- Weapon: this layer require the data showed in the follow image:

 

By choosing the base weapon type, you can ensure the right data and image for your item. 

Spellbook is a special item that do not require the Gargoyle Only property because it will be shown to every race. 

The weapon layer, will also show you the special attacks available like you can see in this picture: 

 

Every special attack has its own description (available in all languages) and the requirements in mana and skills. 

NOTE: choosing wrong data on an item could make the program showing you wrong data in this windows or in other 

parts.  



Now you can add the properties: 

 

Like the skill list you can start to type the property name (with the help of the auto-complete) or pick from the 

dropdown list 

When you have added it, you can edit the values (some properties, like Night Sight, have no values to edit), by clicking 

the value cell. If there is no “0” then that the property has no values. 

You can add as many properties as you want, but realize that in game there is a limit. 

 

 

 

 

  



For each property added you can see growing the Imbuing Weight. The sum is made with the same rule of the game so 

you can also use it for check the weight of an item before imbue it. If you want to exclude a property from the imbuing 

calculator, you can put a check near the property and it will be automatically ignored. 

If you select a property in the table, you’ll be able to see what imbuing reagents are required for the selected property: 

 

 

When you are done, click “File -> Save current item” for save it and you can get it immediately in the layer list. 

In the menu file we have some other buttons: 

- New Item: clear name, layer and properties for allow you to start a new item 

- Save Current Item (CTRL + S): save the item 

- Load Item: allow you to load an item. See the “File Structure” part of this manual for learn more about it. 

- Exit: exit from the tool. 

The menus are the same for every tool and for the main program window, so don’t forget to save your work before 

exiting! 

  



 

However, the advanced menu contains 2 useful tools: 

 

Material Bonus Reference: shows a table with all the materials bonus available in game. 

 

Weapon’s Library: this will show you a table with all the available weapons and data (all data can be sorted by clicking 

the column header).  

 

 

EC Item Imports menu allow you to import the exported item from the Enhanced Client. 

The menu will may result disabled before the export. 

For export a single item just type in game: “I wish to export this item” 

For export an item into a list: “I wish to export this item into a list” 

You can also use the following command for clear the exported item list: “I wish to clear the item list”  

NOTE: you must have the UO Template Editor client mod for use these commands. 

 



Once an item is exported just click “Import a single item” and then the data will be loaded into the Item Maker 

interface, and you must check if the loaded data is correct. The item type detection is not very good (because is 

obtained by the item name), so usually you have to select it manually. The same thing is for the base item type. 

If you want import a list of item, you have to select “Import an item from a list” then you’ll see the list of exported 

items: 

 

Then double click one of the list element for import it. 

Repeat the operation for import the entire list. 

  



UO Assist Item Import 

 

This menu allow you to import the items from UOAssist “Vendor Agent”. Let’s see how to do that! 

1. Put in your backpack a container with all the items that you wish to add 

2. Click "Vendor Bag >>" then "Set Bag". Click on the container. 

 
3. Now you can see the name of the container here: 

 
4. Click on the "Resources" tab, and click on "Count Resources”: 

 



5. Click on the "Agents" Tab, and click "More information…”: 

 
6. Right-click on the list and select "Update items list from vendor bag”: 

 
7. When the list is completely updated click on “Copy list to clipboard”: 

 



8. Now you can go back to UO Template editor and click “Tools -> Import UOAssist Items”: 

 
9. Now if you have done all right, the program shall ask you if you want to automatically save every item or if you 

want to do it manually. 

If you choose to auto-save every item (suggested choice), the program will load every item and will inform you 

when the operation is over. 

If you choose to do it manually, the program shall open an “Item Maker” window for every item, allowing you to 

edit and save it all manually. Remember, if you have huge amount of items, use the auto-save! 

 

NOTE: the auto-save mode may not recognize the right layer of an item. 



Enhanced Client Mod Installation 

 

For install the Enhanced Client Mod that allow you to import Items and Character data you have to do: 

PROCEDURE 1 (No custom interface installed) 

1. Locate the Enhanced Client game folder 

2. Locate the UserInterface folder inside the Enhanced Client forlder 

3. Create a new folder inside the UserInterface folder named “Default1” 

4. Inside Default1 create a new folder named “Mods” 

5. Extract the UOTemplateEditor folder (from the downloaded package) into the Mods folder. 

6. Open the game and press the “Custom UI” button 

7. Select Default1 from the list. 

8. The mod is installed! 

PROCEDURE 2 (Custom interface already installed) 

1. Go into you custom interface folder and locate the “Mods” folder. 

2. Extract the UOTemplateEditor folder (from the downloaded package) into the Mods folder. 

3. The mod is installed!  



Item Set Maker 

 

 

This tool is not more complicated than the “Item Maker”, first you must type the set name in the textbox, then you can 

choose the items. As for the Equipment area, you have a list of the all layers and for each layer you have a list of every 

items for it. To open the list simply click on the 

item cell right on the layer name: 

Now you have another box where you can type 

the name of the item (with the help of the auto-

complete) or choose it from the dropdown list. 

 

 

 

 

After that you have to set the Bonus Properties of the set 

like for the Item Maker: 

push the “Add Property” button, choose the property, click 

on the value cell and set the intensity. 

We have an “Apply to” cell that allow you to set if the 

bonus must be applied to each parts or must be unique. 



When you have finished adding all the needed properties, you can save and your set is ready! 

NOTE: if you have already worn all set parts, you have to remove 1 and wear it again for see the set effects (or simply 

save and re-load your character). To wear a part again you have to select “<NONE>” and remove it and then select the 

item again. 

 

Now let’s take a look into the cleaner… 

 

As I said before, the cleaner is made to safely remove the programs files without damage it. 

For remove an item click in the first dropdown list and choose “Item”, then choose the layer in the same manner (both 

dropdown lists have the auto-complete function if you prefer to type instead of selecting items from a list) 

Once you have selected the layer you have a full list of items (like the Equipment area), then you can select an item and 

press the “Delete” button or simply by press “DEL” on your keyboard. At this point the item is gone. 

You can do the same operation for Pets and Characters, the only difference is the layer dropdown list that is available 

with items only. 

NOTE: deleted files are lost forever; if you want it back you have to make it again. 

  



Bestiary 

 

  

This tool is very easy to use, just select from the list a monster and read the data. The quick search is the same of the 

Equipment Area.  

By clicking the image, it will enlarge (only if is not already in full size). By the context menu you can save it for any 

purpose. 

The bards and taming success chances will be automatically calculated when your bard skills change. 

For see the Provocation Success Chance, you must click on the “Provoke With” line: 

  
and choose the monster to provoke with. 

  



This tool allow you to edit and add new monsters. For do so, let’s go to the File menu and then click “Enable Editing” 

  

When done the “New Beast” and “Save” items on the File menu will be enabled and you can change every value for 

every monster by clicking on the value row for each attribute. You can also change an image by opening the context 

menu on it and click “Change Image”. 

NOTE:  every monster with tamable set to “Yes” will be usable in the stable area. 

 

Now let’s take a look on the bestiary tool: 

Taming Table 

 

  

The taming table will shows all the tamable creature with their relative taming skill, taming success and control chance. 

By changing your skills the table will be updated. You can also double-click on an animal to see more details in a bestiary 

window. 

  



Champion Spawn Table 

 

  

The Champion Spawn Table will show you all the data about the champions spawn. You can also double-click on a 

monster name to see more detail in the bestiary window. 

This tool will also allow you to edit and add champions in the same way of the bestiary. 

  



Slayers Table 

 

  

The Slayer Table will show all the available slayers and then by clicking one of them will show all the affected monster. 

The slayer with the RED text are super slayers, the BLUE text ones are talisman slayers and they have no opposite slayer. 

 

  



Peerless Key Guide 

 

 

It’s almost  done with plain text, but it will show the name of every monster entered into the text onto the monster’s 

reference table. 

Also this tool allow you to edit or add new peerless in the same way of the bestiary. 

  



Collector’s Library 

 

 

The Collector’s Library is a powerful tool that allow you to see and manage your collections. Every change that you 

made is automatically saved (so you don’t need to ensure if is saved or not). 

  



The mains features of this tools are in the context menu: 

  

With this menu you can  

- add new category or sub-category (you can’t make sub-sub-category, only 2 level down the Collections node are 

supported). 

-   Change the category name 

-  Link an item 

  

Linking an item is very easy, just select the layer and the item from this small form and then press ok and the item 

will be linked to the selected category. 

- Create a new item: if you click on “New Item”, the item maker tool will be shown 

- Remove category. 

The menu will change if you click on an item: 

  

In this case you can always make a new item, but you can also Edit the item. If you click edit (or double click on an item 

name) you can edit it on the item maker. 

Removing an item will remove the item from the collection ONLY. 

“Put in My Collection!” will mark the item in red and the tool consider it on your collection. 

“Partial Owned” could be useful for items with many colors, you can mark it as Partial Owned if you want to collect 

every color of the item but you have only few. 

If you use the menu on an item on your collection or partially owned, you can remove the mark. 

The personal notes will be really useful for the partially owned items, because you can write down whatever you want! 

 



The items are shown with the same icons of the equipment area based on their layer, except for the decorative which 

have the “gold ingots” icon and the musical instruments which have the “lute” icon. 

For see their real image you have to click on them 

If you select a stealable artifact, you will see the minimum and maximum spawn time: 

  

The advanced menu, will help you to see less items: 

  

- Show My Collection ONLY: will filter the items and shows only the items in your collection 

-  Hide My Collection: will filter the items and shows only the items outside of your collection (exclude the partially 

owned too). 

Both can be reverted by clicking “Show All”  

  

Reset My Collection: is a PERMANENT reset. Once confirmed, will clear all the marks from every items permanently.  



Part III – Advanced User Guide – 

 

File Structures 
 

Almost every files of the program is made with XML technology and can be edited with a simple text editor like notepad. 

Files are sorted in five folders: 

- Characters: contain the user characters files and avatar images (when you use the save button, the file will be 

created here) 

- Crafting: contains the data of the craftable items, used for calculating the success chance in the “Crafting Info” 

tab. Each file is inside a folder named as its skill. If you change the folder structure, you will also change the data 

in the “Crafting Info”. 

- SkillTraining: contains the training guide for every skill. This files are RTF based and is not suggested to edit them 

manually due to the complexity of the code, just use the proper tool. 

- ExternalTools: this folder contains the external tools given with the software. You can manually add more by 

adding new XML files as described below. 

- PlayerPets: contains all the pets stabled by every characters 

- Items: contains all the items for equipment and the item images. 

- Sets: contains every item set configuration 

- Pets: contains all the tamable beasts 

- SpecialImages: contains all the images of the special attacks of the weapons 

- Peerless: contains the peerless key guides 

- Magic: contains all the file for the spell success chance calculator and the spells description 

- Champions: contains all the files of the Champion Spawn Table tool 

- Bestiary: contains all the files of the non-tamable monsters and the bestiary images 

- BasicItemImages: contains all the basic images for every item 

 

All files have a name structure that MUST NOT BE MODIFIED. Changing this structure will make the file unreadable by 

the program. 

The file name structure is the follow:  

 <char name>_<shard Name>.uteChar -> for characters files 

PlayerPet_<pet name>.xml -> for player pets files 

 <Layer>_<item name>.uteItem -> for items files. Ex. Head_My Item.xml for head layer items. 



 <set name>.uteSet -> for sets files 

 <pet name>.utePet -> for pet types files 

 <pet name>.uteBeast -> for monster types files 

 <custom name>.utePack -> for the exported charcters 

NOTE: The utePack file is not an XML file. Is a compressed file and its content MUST NOT be changed or will be 

corrupted. 

  



The information inside the files has a very easy to read structure. Here is an example: 

 

This is the Armor_Ancient Samurai Do.xml 

As you can see, every XML tag is the property name with “_” 

instead of the space. The tag value is the property value (if they 

have one), as you can see Mage_Armor is an example of a 

property without values. 

If an item has a ”|true” or “|false” after the property value, that 

indicates the flag to count or not that property on the imbuing 

weight calculator. 

Other files: 

- Crafting folders: 

Each folder represents a skill. If a folder has an invalid skill name will be ignored by the program. Inside each 

folder you can see an XML file for every item craftable with that skill. 

This is an example of an item file: 

 
Tag description: 

 MainSkill: this tag design the main crafting skill for that item 

 SecondarySkill: this tag design the secondary crafting skill required for this item 

 Skill: the minimum skill value to craft the item 

 Skill2: the minimum secondary skill value to craft the item 

 Materials: the resources requested for create the item 

 Variation: the skill variation between the minimum skill and the max skill requested for success chance 

(max skill – min skill) 

 Recipe: indicates if the item requires a recipe (accepts only true or false) 

 noExceptional: an item with this tag has no exceptional chance (accepts only true or false) 

 StartTen, StartTwenty, StartThirty, StartFourty, StartFifty: these tags will set the success chance to 10%, 

20%, 30%, 40%, 50% at minimum skill (accepts only true or false) 

 MalusTen: start to calculate the success chance 10.0 skill point later than the minimum skill (accepts 

only true or false) 

 Detract: rarely used, this tag allow you to detract skill point to the minimum skill for item that has a 

success chance calculated with less skill than the minimum requested. 

 

  



- ExternalTools folder: 

Here you can place a new folder with your preferred tools for UO and link them on the program by making an 

XML file like this one: 

 
For add a new program you have to do the same thing of the file below by following this tag guide: 

 Name: the application name 

 Credits: the application creator 

 EXEPath: the path is calculated from UO Template Editor home folder, so you can’t point different 

places. If you want to make a link, I suggest to put the program folder inside the “ExternalTools” folder. 

 ICONPath: an image file for the application.  

NOTE: this file must be a valid image file and not bigger than 32x32 or UO Template Editor could crash 

at startup! 

 

 

 

  



Add Your Own Skills, Item Properties and Caps 
 

If you play in a free shard or OSI, sooner or later they may change something (or something is already different from the 

default program settings), and you have to update your software. I will update the contents files, but if you are hurry, 

here is the way for manually update the software without downloading anything: 

In the main program software you can see some files “.ute”: 

- Skills.ute -> contains the full list of skills, add a row here will add a skill 

- SkillsEC.ute -> contains the full list of skills sorted for the Enhanced Client functions. 

- SopSkills.ute -> contains the full list of soppable skills, add a row here allow a skill to raise its cap to 120 

- Mods.ute -> contains all the item properties, add a row here will add a new property 

- NoValueProps.ute -> contains the full list of the properties without values, add a row here will add another 

property without value (like “Night Sight”) 

- NoSumProps.ute ->  contains the full list of the properties that must not be shown in the “Equipment” area 

table. Like the other files, if you add one row here, you will add another property that must not be combined. 

- PropertyCaps.xml -> contains all property caps, and its structure is the same as the other XML files seen before 

- PropertyItemCap.xml -> contains all property cap (cap for a single item), and its structure is the same as the 

other XML files seen before 

- PropertyWeight.xml -> contains all the imbuing weights of each property, and its structure is the same as the 

other XML files seen before 

- Shards.ute -> contains the name of all shards. If you add one row, you will add one item in the shard list. 

 

Some rules for editing this files: 

1. Make a backup of the interested files before starting 

2. Make a backup of your Characters and PlayerPets folder before start 

3. Be sure to know what are you doing 

4. There is no warranties that your modifications will work, so if something go wrong recover the backups before 

to destroy your saved things. 

5. Don’t ask me questions about custom modifications 

 

What can happen if the modifications are wrong or damaged? 

- The program won’t start 

- The program starts to make corrupted saves (and you can lose items, characters, pets, etc…) 

- The program is destroyed and you have to download it again. 

Definitely the risk is only for your saved configurations of characters, pets, items, etc  and nothing else. There is no 

chance to damage your computer or your operating systems, nor to get virus, spyware, etc… 

 

  



Now let’s see something safer, the item caps editing: 

If you don’t wish to touch the PropertyCaps.xml file (a big file hard to read with high chances of damage it), you can do 

that directly inside the program. 

First open it and go in the Tools menu: 

 

  



Here you see the “Enable Caps Editing”, for start to edit caps you have to click it: 

 

Now you are in the “Equipment” area, but something has changed! 

The set list is now disappeared and you have a big list with every properties. By clicking the cap cell of each property you 

can change the value 

Change the value and then press “Enter” or click 

outside. You can change every caps that you want.  

 

When you have finished your work, click the “Save 

Caps” button and your mod to the caps will be permanent. Then open again the Tool menu: 



 

Now you can see that the “Enable Caps Editing” has disappeared; instead of that you have “Disable Caps Editing”. Click it 

and you will disable the Caps Editing mode. In this manner the Equipment area will have a most readable looks. 

You can activate the Caps Editing mode for see all the properties that the equipment are combines. 

 

  



Multi-Language Support 

 

This software now supports the Multi-Language. For use this feature you need the right language file in your program’s 

folder. 

The language file has this name: 

language.<your language identification>.xml 

the language identification is from ISO 639-1 2 letter’s system (for more information, see 

http://xml.coverpages.org/iso639a.html) 

You can make your own by editing the XML inside the file. Let’s see an example 

<NewCharMenu>New Character</NewCharMenu>  

You can change the tag value, but NOT the tag itself. In this case you can change “New Character “ but 

“<NewCharMenu>” must stay unchanged. 

There are 2 tag that need your attention while you start to edit the languages: 

<Version> : this tag says for what version of the application have you made this language 

<LangCredits> : this tag contains your credits, put here your custom signature (images are not supported, sorry!)  

At the file’s end you will see this area: 

<!--  
 IF YOU EDIT THE PART BELOW, BE SURE TO EDIT ALL THE SKILL AND MODS FILE 

     CHECK THE MANUAL FOR MORE INFORMATIONS  

  

  -->  

  <inscription>Inscription</inscription>  

  <necromancy>Necromancy</necromancy>  

  <chivalry>Chivalry</chivalry>  

  <magery>Magery</magery>  

  <mageweapon>Mage Weapon</mageweapon>  

  <HLD>Hit Lower Defense</HLD>  

  <HLA>Hit Lower Attack</HLA>  

  <TwoHanded>TwoHanded</TwoHanded>  

  <STBonus>Strength Bonus</STBonus>  

 

This area must not be edited if you have not changed the rest of property and skills file (see the “Add Your Own Skills, 
Item Properties and Caps” section of this manual for know how to change it) 
 
If you change “Mana Increase” (inside the “mods.ute” file) in “More Mana”, you have to edit the language file in the 
same manner while changing “Mana Increase” in “More Mana”. 
 
I suggest to DO NOT do that because a little error can cause a lot of crashes. 
Change it only if your language has a different alphabet (like Russian, Chinese, Japanese, etc…). 
 
The stable supported languages are contained in the main packages, and may vary. 
 
NOTE: for a safe translation I suggest to use the “UO Template Editor Translator Tool” included into the package. This 
tool is easy to use and allow you to quickly translate a language file without risks. This tool also support the Google 
Language Instruments for an automatic translation. 
 
If you make a new language file and you want to share it with everyone send it to me to advertsign@guain.it and I’ll test 
it, if it’s stable I’ll put it inside the official package! 

http://xml.coverpages.org/iso639a.html
mailto:advertsign@guain.it


Command Line Parameters 

 
The program support few command line parameters that can allow you to import items from an external source. 

1. prepare|<NUMBER> : if launch the application with this parameter, the application create a buffer for 

<NUMBER> items.  

REMEMBER: the buffer must be precise because the program will wait for that number of items.  

2. autosave : if you use this parameter BEFORE an item, the item will be saved automatically. 

3. <PROPERTY>$<PROPERTY2>$...<PROPERTYn> : you can send to the program an entire item with all properties 

separed by the “$” character.  

4. endOFitems : you can send to the program this parameters for dispose the buffer and stop the import. 

“endOFitems” is not necessary if you send all the prepared number of items, and must be used only in case of 

emergency. 

NOTE: all the parameters must be separated by a SPACE 

The best way to use these parameters is while its running. UO Template Editor can have only 1 instance per time, so if 

you call it again with a parameter, the program will use it! 

Example: 

 Launch the application 

 Re-launch the application with “prepare|10” as parameter. 

 Now the application is in stand-by mode and you cannot use it until all 10 items are loaded 

 Re-launch the application with “autosave spell damage 10%$lower mana cost 5%|weight 1” as parameter. 

 The application receive the item and save it automatically. 

 Continue to send the other 9 items in the same manner 

 When the tenth item is arrived the application return normal and all the 10 items are ready to be used! 

 

There is no other manner to use these commands; an improper use can freeze the program. 

NOTE: importing items this way is slower than the UO Assist one, so use it only if you don’t have other choice (it takes 

about 1-2 seconds per item) 

 

  



Another useful parameter is the equip item: 

1. equip: if you launch the application with the “equip” parameter, the application will equip the item specified 

2. “<layer>|<filename>”: after the equip parameter, you have to specify all the items to equip in that manner: 

layer (for example “head”) then “|” and then the file name. The file name must be already in the item folder. 

Remember to put the “ before layer and after the file name, or it will not work. 

NOTE: this parameter will not freeze the program, so if you made a mistake, nothing happen. 

SUPPORTED “equip” LAYERS: 

Head 

      Ears 

      Neck 

      Talisman 

      Shirt 

      Sash 

      Armor 

      Robe 

      Cloak 

      Belt 

      Arms 

      Gloves 

      Ring 

      Bracelet 

      Weapon 

      Shield 

      Pants 

      Skirt 

      Shoes 

 

The parameter lang is another good option if you use an operative system with a language different than yours. 

You can use it in that manner: 

lang=<TwoLetterIsoLanguageID>: for example “lang=en” will force the program in English 

This parameter could be used only for start the application or it will be ignored. 

NOTE: ensure the language file is available or it will not works! 



 Freeshards and OSI: What You Can’t Change 
 

This software package is based on OSI settings, but as you have see, you can make a lot of modifies for become 

“Freeshard Based”.  

But “What You Can’t Change?” 

1. First of all you can’t change races. The races settings are hardcoded and cannot be modified by users. 

2. You can’t change the “Active Spell Effects” area and its configuration 

3. You can’t change the free overcap by OSI (mining gloves +5 over the cap and blacksmith ancients hammers +10 

to +60 over the cap) 

4. You can’t change the settings for “Hit Lower Defense” and “Hit Lower Attack”. Yes, a part of this setting is in the 

files, but another part is hardcoded. If you remove them from the NoValueProps.ute file, you will make the 

software crash and nothing else. 

5. You can’t change the caps. Maximum skills cap is 700 to 720, 100 to 120 for each skill and the stat cap vary from 

225 to 255. 

6. You can’t add item layers 

7. You can’t add stable slots 

8. You can’t add pet’s attributes 

Basically every modifications that you can do is explained in this part of the manual. If I haven’t explained something, it 

is because you cannot do that by yourself. 

If you need additional features (that are compatible with OSI shards), please send me feedback. 

 

 

 

 

 

 

  

  



Part IV – Support and Future Releases – 

 

How to Get Tech Support 
 

First of all: tech support is only for my software. The support is NOT for your computer problems. 

To contact the tech support you have to register and post in the official forum at: 

http://www.guain.it/UOTemplateEditor/ 

 

If you can open the program, you can get all the contacts data in the “About…” menu: 

When you click on it you will get the credits, the contact info and the donation data. 

 

  

http://www.guain.it/UOTemplateEditor/


Limitations and Warranties 
 

This software is FREE, so you can’t sell it or make any profit by sharing it. There is no fee to pay for using it and everyone 

can use it without limitations. The software is distributed from the internet domain “guain.it“; Other domains are not 

trusted, and you download it from them at your own risk. 

The software does not contains: Spyware, Keygens, Cheats (of any kind), Keylogger, Virus, Trojan or any kind of 

malware. The user is responsible of the use of this, so using third party software for loading data into UO Template 

Editor is not suggested (instead of shards that allow third party softwares). I’m not responsible of eventual items lost, 

accounts lost, bans or any kind of damage caused by an irresponsible use of this software combined with other third 

party software. 

The contents created with UO Template Editor can be shared in any way that you like, but I’m not responsible for the 

contents published by the users, so if something doesn’t work or a modification is not what you’re expecting, contact 

the creator. 

 

  



Feedbacks and Donations 
 

For questions about UO Template Editor, bugs reports, support or feedbacks, you can use the data contained in the 

“Info…” menu or by the official support forum at http://www.guain.it/UOTemplateEditor/ 

There is no other ways to contact me, so don’t ask for it. 

 

Remember that making this software and this manual took a lot of time and a hard work. If you like it please, support it 

with a donation. You can donate an amount of your choice from 1 cent to 100 million dollars. A donation will be your 

“Thanks” and will help to continue the work. 

You can make a donation by clicking the PayPal icon in the “Info…” menu, or manually from your PayPal home by 

sending a donation to: advertsign@guain.it   

Before donating, remember to check always the presence of the yellow lock (like the one in the following image) that 

assure the best safety for online transactions! 

 

http://www.guain.it/UOTemplateEditor/
mailto:advertsign@guain.it
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